ŠTO JE HTML? 

	Sustav koji nam pomaže pri pronalaženju podataka na Internetu zove se World Wide Web (skraćeno: Web, WWW ili W3).
Svaki dokument koji vidimo na Webu napisan je u jeziku zvanom HyperText Markup Language (skraćeno: HTML).
Mi ćemo se ovdje pozabaviti izradom HTML dokumenata pisanjem izvornog koda, što će nas uvesti u samu bit izrade HTML stranica.
	


   
ŠTO JE POTREBNO ZA IZRADU HTML DOKUMENTA?
Za izradu HTML dokumenta potrebno je imati instalirane slijedeće programe:
- browser za pregled HTML dokumenta, u kojem upravo čitate ovaj sadržaj
- običan tekst editor (npr. Notepad) za editiranje HTML koda dokumenata.
    
KAKO OZNAČAVAMO HTML DOKUMENTE?
Svaki HTML dokument ima svoje ime kojem je pridružena extenzija .htm ili .html
Potražite "Address" polje u vašem browseru i pogledajte kako se zove ovaj dokument.
Treba pisati: ...\index.html
    
KAKO VIDJETI IZVORNI KOD HTML DOKUMENTA?
Nakon što u browseru vidite sadržaj nekog HTML dokumenta, do njegovog izvornog koda možete doći na dva načina:

1. - tako da u browseru kliknete desnom tipkom miša i izaberete opciju
"View Source", nakon čega će se otvoriti izvorni kod tog dokumenta.
2. - tako da otvorite svoj tekst editor (npr. Notepad) i pomoću opcije
"File" -> "Open" ... pronađete i otvorite .html dokument koji želite.

Pokušajte to odmah na ovom dokumentu. Kada vam uspije, nemojte ništa mijenjati da ne uništite ovaj dokument, već zatvorite Notepad.
Neka vas ne zbune nerazumljivi kodovi - to je taj HTML kod - koji će vam uskoro postati jasan...
    
KAKO VIDJETI IZMJENE KOJE SMO NAPRAVILI U IZVORNOM KODU HTML-a?
Nakon što ste u svom tekst editoru (npr. Notepadu) napravili izmjene .html dokumenta, potrebno ih je spremiti pomoću opcije "File" -> "Save"
Zatim prijeđite na svoj browser u kojem je učitan taj isti .html dokument i kliknite na dugme "Refresh".

Ako ste dobro postupili, vidjet ćete izmjene koje ste napravili.
Ako izmjene ne vidite, možda ste pogriješili prilikom pisanja izvornog koda.
Vodite računa da HTML, ako naiđe na pogrešnu naredbu u izvornom kodu, ne daje poruku o pogreški već je jednostavno ignorira!
    
OSNOVNA STRUKTURA HTML DOKUMENTA: 

Dakle, svojim HTML dokumentima uvijek dodijelite extenziju .html (na primjer: proba1.html ili proba1.htm).

Nadalje, kada u tekst editoru počnete pisati svoj HTML dokument, morate poštovati određena pravila.

Kao prvo, sve HTML naredbe moraju se nalaziti unutar oznaka < ... >
Sve što se napiše unutar tih oznaka neće biti vidljivo u browseru već će biti tretirano kao naredba HTML-a. 
Sve što se nalazi izvan tih oznaka (npr: <B>ovo je tekst koji će se vidjeti podebljano</B>) bit će vidljivo u browseru.

Većina naredbi ima oznaku za svoj početak i oznaku za svoj kraj. Oznaka za kraj je uvijek znak "/".
Na primjer: <I> je oznaka za početak ukošenih slova a </I> je oznaka za kraj ukošenih slova.
Stoga, sve što upište između te dvije naredbe bit će u browseru vidljivo kao ukošeni ispis...

Naredbe možete i kombinirati. Na primjer:
<B><I>ovo će biti ispisano i podebljano i ukošeno</I></B>
... s tim da oznake za kraj stavljate obrnutim redom u odnosu na redoslijed otvaranja.

Kao drugo, svaki HTML dokument mora imati određenu strukturu:
- oznaku početka <HTML> i oznaku kraja </HTML>,
- zaglavlje <HEAD> </HEAD> unutar kojeg upisujemo opće definicije, poput kodne stranice, podatka o autorstvu, opis dokumenta i dr.
- tijelo <BODY> </BODY> unutar kojeg upisujemo sve ono što želimo da se vidi u browseru.
background = "putanja do slike" - slika kao pozadina dokumenta

bgcolor = "hex broj boje" - boja kao pozadina dokumenta

text = "hex broj boje" - boja teksta cijelog dokumenta

link = "hex broj boje" - boja nikad posjećene poveznice

vlink = "hex broj boje" - boja posjećene poveznice

alink = "hex broj boje" - boja poveznice neposredno prije klika na nju i nakon povratka na stranicu s poveznicom 


Evo primjera s objašnjenjem (crvenom bojom označene su naredbe HTML-a):
	Izvorni kod HTML-a
(vidljiv u Notepadu)
	Objašnjenje
	Rezultat koji vidimo
u browseru

	<HTML>

<HEAD>
<TITLE>Moj prvi HTML</TITLE>
</HEAD>

<BODY>

Prvi red teksta u dokumentu...<BR>
Drugi red teksta u dokumentu...


</BODY>

</HTML>
	početak HTML-a 

početak zaglavlja
naziv dokumenta
kraj zaglavlja

početak tijela

tekst koji će biti
vidljiv u browseru
<BR> prekida red

kraj tijela

kraj HTML-a
	Moj prvi HTML


Prvi red teksta u dokumentu...
Drugi red teksta u dokumentu...




Obzirom da svaki HTML dokument ima istu strukturu (koju vidite u prvoj koloni gornje tablice), izradu novih HTML dokumenata možete si olakšati tako da tu strukturu spremite pod nekim nazivom (npr. blank.htm).
Zatim, kada trebate izraditi novi HTML dokument, prvo u tekst editor učitate taj blank.htm pa ga onda opcijom "File" -> "Save As..." preimenujete u željeno ime i nastavite raditi u njemu. Time izbjegavate stalni upis istih naredbi.

 

I još nešto. Naredbe HTML-a možete pisati i velikim i malim slovima. Tu nema ograničenja. Međutim, bilo bi dobro da ih uvijek pišete velikim slovima kako bi ih lakše razlikovali od ostalog sadržaja.
 
	Tema 1. - OBRADA TEKSTA




a) Ispis i osnovno oblikovanje teksta (<H1>...<H6>, <B>, <I>, <BR>, <HR>)
	HTML naredba
	Objašnjenje
	Rezultat u browseru

	<H1>proba</H1>
	određivanje veličine slova
<H1>-velika ... <H6>-mala
	proba

	<H6>proba</H6>
	određivanje veličine slova
	proba

	<STRONG>proba</STRONG>
ili <B>proba</B>
	ispis podebljanih slova
	proba

	<EM>proba</EM>
ili <I>proba</I>
	ispis ukošenih slova
	proba

	<BR>
	prekid reda - novi red
	-

	<HR>
	ubacivanje vodoravne linije
	


	<HR WIDTH="50%" COLOR="blue" SIZE="1" ALIGN="left">
	vodoravna linija s parametrima
(width=širina, color=boja, size=debljina, align=poravnanje)
	





b) Postavka veličine slova (<FONT SIZE="1">...</FONT>)
	HTML naredba
	Objašnjenje
	Rezultat u browseru

	<FONT SIZE="1">proba</FONT>
	određivanje veličine slova
(SIZE može biti 1 - 7)
	proba 

	<FONT SIZE="7">proba</FONT>
	određivanje veličine slova
	proba 

	<FONT SIZE="-3">proba</FONT>
	smanjenje slova za 3 veličine
	proba

	<FONT SIZE="+3>proba</FONT>
	povečanje slova za 3 veličine
	proba




c) Postavka boje slova (<FONT COLOR="black">...</FONT>)
	HTML naredba
	Objašnjenje
	Rezultat u browseru

	<FONT COLOR="#0000FF">proba</FONT>
	postavka ispisa plavom bojom
(#0000FF = hex.broj plave boje)
	proba

	<FONT COLOR="red">proba</FONT>
	postavka ispisa crvenom bojom
(red = naziv crvene boje)
	proba

	<FONT COLOR="green" SIZE="5">proba</FONT>
	istovremena postavka zelene boje
i veličine slova broj 5
	proba




d) Poravnavanje teksta (<P ALIGN="left">...</P>)
	HTML naredba
	Objašnjenje
	Rezultat u browseru

	<P ALIGN="left">proba</P>
	poravnava tekst uz lijevi rub
(left = lijevo)
	proba

	<P ALIGN="right">proba</P>
	poravnava tekst uz desni rub
(right = desno)
	  proba

	<P ALIGN="center">proba</P>
	poravnava tekst u sredinu ekrana
(center = centar)
	proba


.
	Tema 2. - PODLOGA I ZVUK




a) Postavka boje pozadine dokumenta (<BODY BGCOLOR=...>)
Boja pozadine, kao i ostali elementi pozadine dokumenta, definiraju se samo jednom, unutar <BODY...> naredbe, zato što dokument može imati samo jednu <BODY> naredbu!
	HTML naredba
	Objašnjenje
	Rezultat u browseru

	<BODY BGCOLOR="teal">
proba
	postavka boje pozadine
u "teal" boju
(vodite računa o boji slova
jer sve boje slova nisu
vidljive na svim pozadinama!)
	proba

	<BODY BGCOLOR="aqua">
proba
	postavka boje pozadine
u "aqua" boju
	proba




b) Postavka slike u pozadinu dokumenta (<BODY BACKGROUND=...>)
	HTML naredba
	Objašnjenje
	Rezultat u browseru

	<BODY BACKGROUND="ds-bkgr2.gif">
proba
	postavka slike
"ds-bkgr2.gif"
u pozadinu
	proba

	<BODY BACKGROUND="ds-bkgr3.gif">
proba
	postavka slike
"ds-bkgr3.gif"
u pozadinu
	proba




c) Default boja teksta u dokumentu (<BODY TEXT=...>)
Unutar naredbe <BODY...> može biti i više parametara.
	HTML naredba
	Objašnjenje
	Rezultat u browseru

	<BODY TEXT="aqua" BGCOLOR="teal">
proba
	postavka boje pozadine
i boje teksta dokumenta
	proba

	<BODY TEXT="red" BGCOLOR="aqua">
proba
	postavka boje pozadine
i boje teksta dokumenta
	proba


.


d) Postavka glazbe u pozadinu dokumenta (<BGSOUND SRC="ds-eliza.mid">)
Naredbu za postavku glazbe <BGSOUND...> postavite unutar <HEAD>...</HEAD> strukture.
	HTML naredba
	Objašnjenje
	Rezultat u browseru

	<BGSOUND SRC="ds-eliza.mid" LOOP="infinite">
	postavka glazbe
("ds-eliza.mid")
SRC=datoteka
LOOP=ponavljanje
	(rezultira glazbom)


POZOR: Gornji primjer radit će samo u Internet Exploreru!
Ako želimo aktivirati glazbu tako da bude dostupna i u Internet Exploreru i u Netscape Communicatoru, tada umjesto gornje postavke moramo koristiti slijedeću postavku (koja dolazi unutar <BODY>...</BODY> sekcije):
	HTML naredba
	Objašnjenje
	Rezultat u browseru

	<EMBED SRC="ds-eliza.mid"
WIDTH=0 HEIGHT=0 
HIDDEN="false"
AUTOSTART="true"
LOOP="true">
	- link na datoteku
  "ds-eliza.mid"
- širina i visina objekta
  (0=nevidljiv)
- false=isključi, true=uključi
- da se zvuk uključi
- da se zvuk ponavlja
	(rezultira glazbom)


 

	Tema 3. - RAD SA SLIKAMA




a) Postavka slike u dokument (<IMG SRC=...>)
	HTML naredba
	Objašnjenje
	Rezultat u browseru

	<IMG SRC="ds-img01.jpg">
	postavka slike u dokument
u njenoj punoj veličini
(SRC=naziv slike)
	[image: image1.jpg]





.


b) Određivanje veličine slike (<IMG SRC=... WIDTH=... HEIGHT=...>)
Ako želimo da slika bude manja ili veća od originalne, onda to podesimo s parametrima WIDTH (širina) i HEIGHT (visina). Tom prilikom moramo voditi računa da sliku proporcionalno smanjimo ili uvećamo, kako ne bi došlo do njenog izobličenja.
	HTML naredba
	Objašnjenje
	Rezultat u browseru

	<IMG SRC="ds-img01.jpg"
WIDTH="96" HEIGHT="64">
	postavka slike u dokument
(WIDTH="96" = širina 96 pixela)
(HEIGHT="64" = visina 64 pixela)
	[image: image2.jpg]


  

	<IMG SRC="ds-smile.gif">
	ovako izgleda ako u dokument
uključimo animiranu GIF sliku
	[image: image3.png]







c) Poravnavanje slike u dokumentu (<IMG SRC=... ALIGN=....>)
	HTML naredba
	Objašnjenje
	Rezultat u browseru

	<IMG SRC="ds-img02.jpg" ALIGN="left">
probni tekst
probni tekst
	poravnavanje slike u lijevo
	  [image: image45.jpg]



probni tekst
probni tekst

	<IMG SRC="ds-img03.jpg" ALIGN="right">
probni tekst
probni tekst
	poravnavanje slike u desno
	  [image: image46.jpg]



probni tekst
probni tekst




d) Komentar za sliku i okvir oko slike (<IMG SRC=... ALT=.... BORDER=...>)
Unutar naredbe <IMG SRC=...> možemo postaviti više parametara.
	HTML naredba
	Objašnjenje
	Rezultat u browseru

	<IMG SRC="ds-img02.jpg" ALT="kanjon">
	komentar se pojavljuje kada
nad sliku postavimo miša
(u ovom slučaju: "kanjon")
	  [image: image4.jpg]




	<IMG SRC="ds-img03.jpg" ALT="ledenjak" BORDER="4">
	opcija BORDER=4 određuje
okvir oko slike debljine 4 pixela.
(BORDER=0 - ukida okvir)
	  [image: image5.jpg]





 

	Tema 4. - RAD S TABLICAMA




a) Definiranje dimenzija tablice
Dimenzija tablice predstavljena je brojem kolona (okomito) i brojem redova (vodoravno).
Svako pojedino polje unutar tablice zove se čelija, unutar koje se može upisati neki tekst, postaviti slika ili kombinirati oboje.
U svakoj tablici može se podesiti debljina njenog okvira (BORDER), te širina i visina tablice u odnosu na veličinu ekrana (WIDTH/HEIGHT) kao i druge opcije.
	HTML naredba
	Objašnjenje
	Rezultat u browseru

	<TABLE border=1>
   <TR>
      <TD>
           proba
      </TD>
   </TR>
</TABLE>
	oznaka početka tablice
početak prvog reda u tablici
početak prve kolone u tablici
tekst koji će se vidjeti u čeliji
kraj prve kolone u tablici
kraj prvog reda u tablici
oznaka kraja tablice
	   proba   


	<TABLE border=5>
   <TR>
      <TD>kolona1</TD>
      <TD>kolona2</TD>
      <TD>kolona3</TD>
   </TR>
</TABLE>
	Primjer tablice s jednim redom, tri kolone i okvirom debljine 5 pix.

Prvo definirate red sa <TR> a zatim naredbama <TD> ubacujete jednu po jednu kolonu

Svaki <TR> mora imati svoj </TR> i svaki <TD> svoj </TD>
	 kolona1 

 kolona2 

 kolona3



	<TABLE border=1>
    <TR>
      <TD>red1-kolona1</TD>
      <TD>red1-kolona2</TD>
   </TR>
    <TR>
      <TD>red2-kolona1</TD>
      <TD>red2-kolona2</TD>
   </TR>
    <TR>
      <TD>red3-kolona1</TD>
      <TD>red3-kolona2</TD>
   </TR>
</TABLE>
	Primjer tablice sa tri reda, dvije kolone i okvirom debljine 1 pix.

Naravno, za izradu tablica danas postoje mnogi pomoćni alati pa nema potrebe da se ovako "ručno" patimo sa izradom!

Ovaj primjer treba samo poslužiti da bi shvatili način na koji se tablica generira...
	 red1-kolona1 

 red1-kolona2 

 red2-kolona1 

 red2-kolona2 

 red3-kolona1 

 red3-kolona2 






b) Boja podloge u tablici (TABLE BGCOLOR="...")
U svakoj tablici može se podesiti boja podloge cijele tablice ili samo njenih pojedinih čelija (BGCOLOR).
	HTML naredba
	Objašnjenje
	Rezultat u browseru

	<TABLE border=1 bgcolor="yellow">
    <TR>
      <TD>red1-kolona1</TD>
      <TD>red1-kolona2</TD>
   </TR>
 
  <TR>
      <TD>red2-kolona1</TD>
      <TD bgcolor="aqua">
         red2-kolona2
      </TD>
   </TR>
</TABLE>
	primjer tablice sa dva reda, dvije kolone i okvirom debljine 1 pix.

<TABLE ... bgcolor="yellow">
postavlja žutu podlogu cijele tablice

<TD bgcolor="aqua">
postavlja plavu podlogu samo u toj čeliji!
	 red1-kolona1 
 red1-kolona2 
 red2-kolona1 
 red2-kolona2 





c) Slika kao podloga u tablici (TABLE BACKGROUND="...")
Za podlogu (pozadinu) tablice ili njenih čelija umjesto boje (BGCOLOR) možemo postaviti i sliku (BACKGROUND).
	HTML naredba
	Objašnjenje
	Rezultat u browseru

	<TABLE border=5
background="ds-bkgr3.gif">
   <TR>
      <TD>kolona1</TD>
      <TD>kolona2</TD>
      <TD>kolona3</TD>
   </TR>
</TABLE>
	Primjer tablice s jednim redom, tri kolone, okvirom debljine 5 pix. i slikom u pozadini.

Sliku pozadine cijele tablice učitavamo opcijom
<TABLE background="ds-bkgr3.gif">
	

kolona1 


kolona2 


kolona3 


	<TABLE border=5 
background="ds-bkgr1.jpg">
   <TR>
      <TD>kolona1</TD>
      <TD>kolona2</TD>
      <TD background="ds-bkgr2.gif">
         kolona3
      </TD>
   </TR>
</TABLE>
	Primjer sa slikom u pozadini,
s tim što je u zadnjoj čeliji definirana
posebna slika za pozadinu.

Sliku pozadine određene čelije
učitavamo opcijom
<TD background="ds-bkgr3.gif">
	

kolona1 


kolona2 


kolona3 



.


d) Ubacivanje slike u tablicu
Polja tablice mogu osim teksta sadržavati i druge objekte, pa tako i slike.
Treba razlikovati slike koje koristimo za podlogu/pozadinu u tablici od onih koje učitavamo u polje tablice!
Princip učitavanja slike u tablicu ne razlikuje se od uobičajenog postupka za učitavanje slike.
	HTML naredba
	Objašnjenje
	Rezultat u browseru

	<TABLE border=5>
   <TR>
      <TD>
         <IMG SRC="ds-img01.jpg">
      </TD>
      <TD>
         ...kolona2...<BR>
         ...kolona2...
      </TD>
      <TD ALIGN="center">
         kolona3<BR>
         <IMG SRC="ds-img02.jpg">
         kolona3<BR>
         kolona3
      </TD>
   </TR>
</TABLE>
	Primjer tablice sa jednim redom,
tri kolone i okvirom debljine 5 pix.

U prvu i treću kolonu (čeliju)
učitali smo slike, koristeći opciju
... <IMG SRC="ds-img01.jpg">...
unutar tih čelija.

U trećoj koloni (čeliji)
kombinirali smo tekst i sliku,
s tim da smo sve to centrirali sa
<TD ALIGN="center">
	[image: image6.jpg]



...kolona2...
...kolona2...
kolona3
[image: image7.jpg]



kolona3
kolona3



 
	Tema 5. - RAD S LISTAMA




a) Liste oblika DIR i MENU
Liste koristimo kada želimo urediti neki popis ili u nekom redoslijedu nešto navesti.
	HTML naredba
	Objašnjenje
	Rezultat u browseru

	<DIR>
<LI>Prva stavka
<LI>Druga stavka
<LI>Treća stavka
</DIR>
	lista oblika DIR
	  Prva stavka
  Druga stavka 
  Treća stavka 

	<MENU>
<LI>Prva stavka
<LI>Druga stavka
<LI>Treća stavka
</MENU>
	lista oblika MENU
	  Prva stavka
  Druga stavka 
  Treća stavka 




b) Lista oblika OL
Ako u svoj popis želimo uvrstiti redne brojeve ili slične oznake, možemo koristiti neku od slijedećih opcija:
	HTML naredba
	Objašnjenje
	Rezultat u browseru

	<OL>
<LI>Prva stavka
<LI>Druga stavka
<LI>Treća stavka
</OL>
	obična lista oblika OL
	1. Prva stavka 
2. Druga stavka 
3. Treća stavka 

	<OL TYPE="I">
<LI>Prva stavka
<LI>Druga stavka
<LI>Treća stavka
</OL>
	lista oblika OL TYPE="I"
	I. Prva stavka 
II. Druga stavka 
III. Treća stavka 

	<OL TYPE="a">
<LI>Prva stavka
<LI>Druga stavka
<LI>Treća stavka
</OL>
	lista oblika OL TYPE="a"
	a. Prva stavka 
b. Druga stavka 
c. Treća stavka 

	<OL TYPE="1" START="5">
<LI>Prva stavka
<LI>Druga stavka
<LI>Treća stavka
</OL>
	lista oblika
OL TYPE="1" START="5"
(počinje od broja 5...)
	5. Prva stavka 
6. Druga stavka 
7. Treća stavka 

	<OL TYPE="a" START="3">
<LI>Prva stavka
<LI>Druga stavka
<LI>Treća stavka
</OL>
	lista oblika
OL TYPE="a" START="3"
(počinje od trećeg slova - c)
	c. Prva stavka 
d. Druga stavka 
e. Treća stavka 


.


c) Lista oblika UL
	HTML naredba
	Objašnjenje
	Rezultat u browseru

	<UL>
<LI>Prva stavka
<LI>Druga stavka
<LI>Treća stavka
</UL>
	obična lista oblika UL
	· Prva stavka 
· Druga stavka 
· Treća stavka 

	<UL TYPE="circle">
<LI>Prva stavka
<LI>Druga stavka
<LI>Treća stavka
</UL>
	lista oblika UL TYPE="circle"
	· Prva stavka 
· Druga stavka 
· Treća stavka 


.


d) Lista oblika DL
	HTML naredba
	Objašnjenje
	Rezultat u browseru

	<DL>
<DT>Prva stavka <DD>Objašnjenje prve stavke...
<DT>Druga stavka <DD>Objašnjenje druge stavke...
<DT>Treća stavka <DD>Objašnjenje treće stavke...
</DL>
	lista oblika DL
	Prva stavka 

Objašnjenje prve stavke... 
Druga stavka 

Objašnjenje druge stavke... 
Treća stavka 

Objašnjenje treće stavke... 


 

	Tema 6. - IZVEDBA LINKA




a) Link na drugu HTML stranicu pomoću teksta (A HREF=...)
Hiperveze su posebno označene riječi, fraze ili slike u HTML dokumentima.
Klikom na njih prebacujete se na neki drugi HTML dokument, sliku ili servis.
	HTML naredba
	Objašnjenje
	Rezultat u browseru

	Ovo je link na
<A HREF="ds-color.htm">
popis boja
</A>
za HTML
	Definiranje linka na
HTML dokument
ds-color.htm
	Ovo je link na popis boja za HTML

	Ovo je link na
<A HREF="ds-img03.jpg">
sliku ledenjaka
</A>
	Definiranje linka
na sliku ledenjaka
ds-img03.jpg
	Ovo je link na sliku ledenjaka




b) Link na drugu HTML stranicu pomoću slike
Osim tekstom, link možemo izvesti i pomoću slike...
	HTML naredba
	Objašnjenje
	Rezultat u browseru

	(Za pregled boja klikni na sliku)
<A HREF="ds-color.htm">
<IMG SRC="ds-img01.jpg">
</A>
	Link na  dokument
ds-color.htm
pomoću slike
ds-img01.jpg
	(Za pregled boja klikni na sliku)





.


c) Link na oznaku na istoj HTML stranici (A NAME=...)
Ako imamo jedan duži HTML dokument, korisno je da njegove pojedine dijelove označimo naredbom NAME i nekim imenom kako bi korisniku omogućili da lakše i brže prelazi s jednog na drugi dio dokumenta, pomoću linkova koje smo prethodno obradili.
	HTML naredba
	Objašnjenje
	Rezultat u browseru

	Izaberite:<BR><BR>
<A HREF="#oznaka1">Tema 6.a</A>
<A HREF="#oznaka2">Tema 6.d</A>
....................
....................
<A NAME="oznaka1"></A>
TEMA 6.a: <BR>
xxxxx xxxxx xxxxx xxxxx <BR>
xxxxx xxxxx xxxxx xxxxx <BR>

<A NAME="oznaka2"></A>
TEMA 6.d: <BR>
xxxxx xxxxx xxxxx xxxxx <BR>
xxxxx xxxxx xxxxx xxxxx <BR>
	Ako unutar html dokumenta
stavimo oznaku NAME, npr:
<A NAME="oznaka1"></A>

tada pomoću linka u obliku:
<A HREF="#oznaka1">Tema 6.a</A>

automatski prelazimo na mjesto
u našem HTML dokumentu
gdje smo oznaku NAME stavili.
	Izaberite:

Tema 6.a


 HYPERLINK "http://www.1osb.ims.hr/skola/html/ds-tema6.htm" \l "oznaka2#oznaka2" Tema 6.d


.


d) Ostali linkovi:
· link na e-mail (A HREF="mailto:moja.email@adresa.hr") 

· link na download (A HREF="dopisna1.zip") 

Link je moguće napraviti i na e-mail adresu.
U tom slučaju otvara se program za e-mail i omogućava se korisniku da napiše pismo i pošalje ga, ukoliko ima ispravno podešen program za e-mail...

Nadalje, ako za link navedemo dokument koji ima: .EXE .MP3 ili .ZIP ekstenziju, takav dokument neće se otvarati u browseru, niti pokretati, već će se automatski pokrenuti njegov download (skidanje sa neke adrese i spremanje u neki od foldera na našem računalu)...
	HTML naredba
	Objašnjenje
	Rezultat u browseru

	Pišite na
<A HREF="mailto:moja.email@adresa.hr">
moju adresu.
</A>
	Primjer uporabe
linka na e-mail
	Pišite na moju adresu. 

	Pokrenite download <BR>
igre MEMORY klikom <BR>
<A HREF = "ds-memo.zip">
o v d j e !
</A>
	Primjer pokretanja
downloada igre
zipovane u fajl
ds-memo.zip
	Pokrenite download
igre MEMORY klikom
o v d j e !


.
 

	Tema 7. - DEFINIRANJE MAPE SLIKE




a) Općenito o mapi slike
Do sada smo naučili kako možemo izvesti link pomoću neke slike.
Međutim, u HTML-u postoji mogućnost da na jednoj slici definiramo više područja od kojih svako može upućivati na drugi link...

Za početak, prvo moramo izraditi ili izabrati neku pogodnu sliku.
Zatim, u nekom pogodnom editoru slika, izračunamo i zabilježimo početne i krajnje pozicije područja koje želimo koristiti za linkove.

Za izradu mape slike postoje mnogi specijalizirani programi koji automatski izračunavaju potrebne parametre, međutim, kako bi bolje razumjeli izvorni način definiranja ovih područja, evo nekoliko napomena:

- Kao mjerne jedinice koristimo isključivo pixele.
- Orjentacije radi, gornji lijevi kut slike uvijek predstavlja početni kut (x=0 pixela, y=0 pixela)
- X-osa je zamišljena vodoravna linija koja počinje u gornjem lijevom kutu i proteže se na desno...
- Y-osa je zamišljena okomita linija koja počinje u gornjem lijevom kutu i proteže se prema dnu slike...

Područja koja na slici definiramo zovu se AREA i mogu biti u tri oblika (SHAPE), i to:
· RECT - oblik četverokuta, za koji moramo definirati početni (gornji lijevi) i završni (donji desni) kut, s tim da za svaki kut prvo zabilježimo vrijednost u pixelima za X-osu pa onda za Y-osu. Dakle, ova definicija ima 4 broja, i to: x1, y1, x2, y2. 

· CIRCLE - oblik kruga, za koji moramo definirati središte kruga (prvo po X-osi pa onda po Y-osi) i zatim polumjer kruga. Dakle, ova definicija ima ukupno 3 broja, i to: x, y, r. 

· POLY - oblik poligona (lik s minimalno 3 stranice, pa nadalje...) za koji moramo definirati svaku točku prijeloma (prvo po X-osi pa onda po Y-osi). Dakle, ova definicija uvijek ima duplo više brojeva od broja stranica lika koji predstavlja (x1, y1, x2, y2, x3, y3, x4, y4, x5, y5 - za peterokut, na primjer)... 

No, da previše ne teoretiziramo (obzirom da je u praksi sve ovo jednostavnije nego što se na prvi pogled čini!) evo jednog primjera.

Dolje sam izabrao jednu sliku veličine 300 pixela po X-osi (vodoravnoj) i 200 pixela po Y-osi (okomitoj). Pogledajte oznake tih osa!
Početno mjesto za svaki daljnji obračun je gornji lijevi kut slike (0 pixela i po X i po Y osi - kako i piše).
[image: image9.jpg]



(Plava boja na slici predstavlja samo mjerilo za orjentaciju!)
Na slici sam namjerno crvenom bojom nacrtao slijedeće likove:
· KRUG (CIRCLE), sa centrom na poziciji X=75 pixela, Y=80 pixela i s radijusom R=50 pixela. Uočite te pozicije!
U HTML-u takvo bi područje obilježili kao:
<AREA SHAPE="CIRCLE" COORDS="75,80,50" HREF="stranica1.htm">
· ČETVEROKUT (RECT), s početnom pozicijom na X=200 pixela, Y=30 pixela i s krajnjom pozicijom na X=280 pixela, Y=130 pixela. Uočite te pozicije!
U HTML-u takvo bi područje obilježili kao:
<AREA SHAPE="RECT" COORDS="200,30,280,130" HREF="stranica2.htm">
· POLIGON (POLY), s prvom točkom na X=100 pixela, Y=150 pixela, drugom točkom na X=170 i Y=130 pixela, trećom točkom na X=230 i Y=170 pixela i četvrtom točkom na X=120 i Y=180 pixela. Uočite te pozicije!
U HTML-u takvo bi područje obilježili kao:
<AREA SHAPE="POLY" COORDS="100,150,170,130,230,170,120,180" HREF="stranica3.htm">
U navedenim naredbama parametar COORDS=... popunjavamo gore navedenim pozicijama po X/Y osi, točno onim redoslijedom kako je navedeno u objašnjenju, dok HREF=... predstavlja link (adresu) HTML stranice koju želimo učitati kada korisnik klikne mišem na tom području.
Parametri AREA i SHAPE objašnjeni su već prije.

Kompletna definicija MAPE slike u HTML dokumentu dolazi unutar <BODY> strukture i izgledala bi ovako:
	HTML naredba
	Objašnjenje
	Rezultat u browseru

	<MAP NAME="MapaSlike1">

<AREA SHAPE="CIRCLE"
COORDS="75,80,50"
HREF="ds-img01.jpg">

<AREA SHAPE="RECT"
COORDS="200,30,280,130"
HREF="ds-img02.jpg">

<AREA SHAPE="POLY"
COORDS=
"100,150,170,130,230,170,120,180"
HREF="ds-img03.jpg">

</MAP>

<img src="ds-mapa.jpg" border="0"
width="300" height="200"
usemap="#MapaSlike1">
	početak i ime mape

oblik kruga,
koordinate i
odredišni link

oblik kvadrata,
koordinate i
odredišni link

oblik poligona,
koordinate i
odredišni link

kraj mape

poziv mape
IMG naredbom
uz navod imena
(USEMAP=...)
	[image: image10.png]





Dok prelazite mišem preko područja kruga, četverokuta ili poligona koji su nacrtani na gornjoj slici, primjetit ćete da se radi o područjima koja upućuju na linkove.
Krug ima link na sliku "ds-img01.jpg", četverokut na sliku "ds-img02.jpg" a poligon na sliku "ds-img03.jpg").
Na isti način linkovi su mogli upućivati i na druge HTML stranice.

 


b) Područje u obliku četverokuta (AREA SHAPE="RECT"...)
Ovdje ćemo pojednostaviti i definirati mapu slike gdje će biti aktiviran samo oblik četverokuta (RECT):
	HTML naredba
	Objašnjenje
	Rezultat u browseru

	<MAP NAME="MapaSlike1">

<AREA SHAPE="RECT"
COORDS="200,30,280,130"
HREF="ds-img02.jpg">

</MAP>

<img src="ds-mapa.jpg" border="0"
width="300" height="200"
usemap="#MapaSlike1">
	početak i ime mape

oblik kvadrata,
koordinate i
odredišni link

kraj mape

poziv mape
IMG naredbom
uz navod imena
(USEMAP=...)
	[image: image11.png]





.


c) Područje u obliku kruga (AREA SHAPE="CIRCLE"...)
Ovdje ćemo definirati mapu slike gdje će biti aktiviran samo oblik kruga (CIRCLE):
	HTML naredba
	Objašnjenje
	Rezultat u browseru

	<MAP NAME="MapaSlike1">

<AREA SHAPE="CIRCLE"
COORDS="75,80,50"
HREF="ds-img01.jpg">

</MAP>

<img src="ds-mapa.jpg" border="0"
width="300" height="200"
usemap="#MapaSlike1">
	početak i ime mape

oblik kruga,
koordinate i
odredišni link

kraj mape

poziv mape
IMG naredbom
uz navod imena
(USEMAP=...)
	[image: image12.png]





.


d) Područje u obliku poligona (AREA SHAPE="POLY"...)
Ovdje ćemo definirati mapu slike gdje će biti aktiviran samo oblik poligona (POLY):
	HTML naredba
	Objašnjenje
	Rezultat u browseru

	<MAP NAME="MapaSlike1">

<AREA SHAPE="POLY"
COORDS=
"100,150,170,130,230,170,120,180"
HREF="ds-img03.jpg">

</MAP>

<img src="ds-mapa.jpg" border="0"
width="300" height="200"
usemap="#MapaSlike1">
	početak i ime mape

oblik poligona,
koordinate i
odredišni link

kraj mape

poziv mape
IMG naredbom
uz navod imena
(USEMAP=...)
	[image: image13.png]





 

	Tema 8. - RAD S FORMAMA




Opće o formama
Forme u HTML dokumentu koristimo kada od korisnika želimo prihvatiti neki podatak i zatim ga proslijediti na daljnju obradu, spremiti ga u bazu podataka ili ga jednostavno poslati e-mailom na određenu adresu.

Na primjer, korisne su ako želimo pribaviti podatke o nekom korisniku, obaviti neku anketu ili pak korisniku omogućiti da popuni i pošalje nekakvu narudžbu putem Interneta u cilju kupovine nekog proizvoda.

Princip rada forme je otprilike slijedeći (krajnje pojednostavljeno):
· korisnik popuni polja koja su mu ponuđena 

· klikne na tipku "SUBMIT" ili "POŠALJI" 

· podaci upisani u formu bivaju proslijeđeni do određenog programa na serveru (tzv. CGI skripte, pisane npr. u Javi, Perlu, PHP-u, ASP-u ili nekom drugom jeziku) 

· taj program ih prihvaća, obrađuje ih, sprema u bazu podataka, šalje povratnu informaciju, ili radi nešto slično, ovisno već o njegovoj namjeni... 

Obzirom da je korištenje formi uglavnom vezano za posebne programe (CGI skripte) te da je na serveru na koji ih postavljamo potrebno imati otvoren pristup tzv. CGI-BIN folderu, ovdje ih nećemo detaljnije obrađivati jer njihovo korištenje zahtjeva veće programersko iskustvo u pisanju programa koji prihvaćaju i obrađuju podatke s formi a također i zakupljeni WEB prostor na nekom serveru...

No, za početak je bitno da shvatimo kako to otprilike funkcionira!

U tom cilju naučit ćemo kako izraditi neku jednostavniju formu i kako podatke s te forme možemo jednostavno poslati na željenu e-mail adresu - a što ne zahtjeva baš nikakvo znanje u izradi CGI skripti!

Jedini je uvjet za to da vi posjedujete svoju e-mail adresu (bilo gdje) i da korisnik koji popunjava vašu formu (negdje na drugoj strani svijeta, na primjer) posjeduje ISPRAVNO PODEŠEN PROGRAM ZA E-MAIL na svome kompjuteru!

Pa da krenemo!


a) Polja za upis u obliku <INPUT TYPE="text"...> i obliku <TEXTAREA ...>
Dakle, ovdje ćemo govoriti samo o formama čije podatke šaljemo putem e-maila!
Svaki HTML dokument može imati više formi, s tim da svaka počinje slijedećim tagom:

<FROM ACTION="mailto:moja.email@adresa.hr" METHOD="post">
i završava tagom:
</FORM>

<FORM...> predstavlja početak forme, a
</FORM> predstavlja kraj forme.
Opcija ACTION="mailto:...." određuje e-mail adresu na koju će podaci sa forme biti poslani.
Opcija METHOD="post" određuje da se podaci sa forme šalju na definirano odredište.

Ostaje nam još samo da naučimo kako definirati polja za upis podataka:
	HTML naredba
	Objašnjenje
	Rezultat u browseru

	<FORM
ACTION="mailto:moja.email@adresa.hr"
METHOD="post">

Upišite svoje ime:<BR>
<input type="text"
size="20"
maxlength="20"
name="IME">

<input type="submit" value="Pošalji"> 
<input type="reset" value="Prekini">

</FORM>
	- početak forme
- e-mail adresa
- slanje podataka

- proizvoljan tekst
- stavlja tekst-polje
- širine 20 znakova
- moguć upis 20 zn.
- naziv polja=IME

- stavlja gumb "Pošalji"
- stavlja gumb "Prekini"

- kraj forme
	Top of Form

Upišite svoje ime:

[image: image14.wmf]
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Bottom of Form

	<FORM
ACTION="mailto:moja.email@adresa.hr"
METHOD="post">

Upišite svoje ime:<BR>
<input type="text"
size="20"
maxlength="20"
name="IME">

Upišite svoj komentar:<BR>
<textarea
name="KOMENTAR"
rows="5"
cols="20">
</textarea>

<input type="submit" value="Pošalji"> 
<input type="reset" value="Prekini">

</FORM>
	- početak forme
- e-mail adresa
- slanje podataka

- proizvoljan tekst
- stavlja tekst-polje
- širine 20 znakova
- moguć upis 20 zn.
- naziv polja=IME

- proizvoljan tekst
- stavlja tekst-područje
- naziv polja...
- visina 5 redova
- širina 20 znakova
- kraj tekst-područja

- stavlja gumb "Pošalji"
- stavlja gumb "Prekini"

- kraj forme
	Top of Form

Upišite svoje ime:
[image: image17.wmf]



Upišite svoj komentar:
[image: image18.wmf]
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Bottom of Form


POZOR: Ako formu popunite na vlastitom kompjuteru i pokušate podatke poslati na svoj vlastiti e-mail, najvjerojatnije vam ta "rabota" neće uspjeti jer većina e-mail programa ne dozvoljava slanje pošte sa vlastite e-mail adrese na vlastitu e-mail adresu! Zato za probu možete koristiti moju e-mail adresu koja je navedena u primjerima!

Nadalje, kada popunite polja forme i kliknete na gumb "Pošalji", bit ćete upitani želite li putem e-maila poslati ove podatke. Kliknite na "OK". 
- Ako ste trenutno spojeni na Internet (ONLINE) podaci će automatski otići na određenu adresu (u ovom slučaju moju, što slobodno možete isprobati - a ja ću vam e-mailom odgovoriti da li sam to dobio i u kojem obliku!).
- Ako trenutno niste spojeni na Internet (OFFLINE), bit ćete upitani želite li se spojiti i poslati ovu poštu ili želite ostati "offline", tj. tu poštu samo staviti u spremnik za slanje i poslati je kasnije, kada se spojite na Internet...

Naravno, da bi sve ovo radilo kako treba, morate imati ISPRAVNO PODEŠEN PROGRAM ZA E-MAIL!!!

Informacije radi, podaci iz polja forme bit će poslani uz e-mail kao "attachment" datoteka.
Ta datoteka je tekstualnog oblika i u njoj su navedeni podaci o imenima polja (NAME) i podacima upisanim u njih.
Na prvi pogled i nije sve tako čitljivo kako mislite da bi trebalo biti, ali ne brinite, brzo ćete ih "dešifrirati"... :o)))




b) Polja za upis u obliku <SELECT...> / <OPTION>
Ovdje ćemo prikazati uporabu navedenog polja, koje možete kombinirati s ostalim vrstama polja:
	HTML naredba
	Objašnjenje
	Rezultat u browseru

	<FORM
ACTION="mailto:moja.email@adresa.hr"
METHOD="post">

Mislim da je ova škola HTML-a: 
<select name="PROCJENA" size="1">
<option>Dobra ideja </option>
<option selected>Prosječna ideja </option>
<option>Slaba ideja </option>
</select> 

<input type="submit" value="Pošalji"> 
<input type="reset" value="Prekini">

</FORM>
	- početak forme
- e-mail adresa
- slanje podataka

- proizvoljan tekst
- početak izbornika
- 1. opcija izbora
- 2. opcija/default
- 3. opcija izbora
- kraj izbornika

- stavlja gumb "Pošalji"
- stavlja gumb "Prekini"

- kraj forme
	Top of Form

Mislim da je ova škola HTML-a:

[image: image21.wmf]
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c) Polja za upis u obliku <INPUT TYPE="checkbox"...>
Ovdje ćemo prikazati uporabu navedenog polja, koje možete kombinirati s ostalim vrstama polja:
	HTML naredba
	Objašnjenje
	Rezultat u browseru

	<FORM
ACTION="mailto:moja.email@adresa.hr"
METHOD="post">

Označite željene stavke:
<input type="checkbox"
name="KNJIGA1"
value="ON">
Naručujem knjigu HTML-a

<input type="checkbox"
checked
name="KNJIGA2"
value="ON">
Naručujem knjigu JavaScripta

<input type="submit" value="Pošalji"> 
<input type="reset" value="Prekini">

</FORM>
	- početak forme
- e-mail adresa
- slanje podataka

- proizvoljan tekst
- stavlja checkbox
- naziv checkboxa
- (obavezan tag)
- proizvoljan tekst

- stavlja checkbox
- default označen!
- naziv checkboxa
- (obavezan tag)
- proizvoljan tekst

- stavlja gumb "Pošalji"
- stavlja gumb "Prekini"

- kraj forme
	Top of Form

OZNAČITE ŽELJENE STAVKE:

[image: image24.wmf]Naručujem knjigu HTML-a
[image: image25.wmf]Naručujem knjigu JavaScripta
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d) Polja za upis u obliku <INPUT TYPE="radio"...>
Ovdje ćemo prikazati uporabu navedenog polja, koje možete kombinirati s ostalim vrstama polja:
	HTML naredba
	Objašnjenje
	Rezultat u browseru

	<FORM
ACTION="mailto:moja.email@adresa.hr"
METHOD="post">

Koju boju više volite:

<input type="radio"
name="BOJA"
value="Plava">
Volim plavu boju

<input type="radio"
checked
name="BOJA"
value="Zelena">
Volim zelenu boju

<input type="submit" value="Pošalji"> 
<input type="reset" value="Prekini">

</FORM>
	- početak forme
- e-mail adresa
- slanje podataka

- proizvoljan tekst

- stavlja radio-polje
- naziv pitanja (BOJA)
- naziv odgovora (Plava)
- proizvoljan tekst

- stavlja radio-polje
- default označeno polje
- naziv pitanja (BOJA)
- naziv odgovora (Zelena)
- proizvoljan tekst

- stavlja gumb "Pošalji"
- stavlja gumb "Prekini"

- kraj forme
	Top of Form

KOJU BOJU VIŠE VOLITE:

[image: image28.wmf]Volim plavu boju
[image: image29.wmf]Volim zelenu boju
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	Tema 9. - D O P U N E




a) Postavka hrvatskih slova
Obzirom da će vaše WEB stranice, kada ih postavite na Internet, biti dostupne ljudima svih govornih područja i jezičnih skupina, morate voditi računa o tome da u svom HTML dokumentu definirate kodnu stranicu govornog područja na čijem jeziku je taj dokument napravljen.
U našem slučaju radi se o kodnoj stranici "windows-1250" (ispravna je i postavka "ISO-8859-2").
Definiranje kodne stranice obavljate unutar <HEAD> sekcije i time osiguravate da korisnik vaše WEB stranice na svom ekranu uvijek vidi odgovarajuća HR slova (š, đ, č, ć, ž) ukoliko posjeduje tu mogućnost u svom browseru i ako je ona dobro podešena.
Dakle, unutar <HEAD> sekcije svih svojih HTML dokumenata obavezno ubacite:
	HTML naredba za postavku HR slova

	<HEAD>
<meta http-equiv="Content-Type" content="text/html; charset=windows-1250">
</HEAD>




b) Specijalni znakovi
Primjetili ste do sada da pojedini znakovi predstavljaju naredbe HTML-a (posebno < > a unutar njih # & " ...)
Nadalje, primjetit ćete da koliko god vi razmaka (razmaknicom) u HTML-u stavljali, uzet će se u obzir samo jedan (prvi) razmak!
Dakle, što ako unutar svog teksta zatrebamo upravo te znakove ili poželimo staviti više razmaka?
Ako znate što su to ASCII kodovi znakova u nekoj kodnoj stranici, stvar postaje jednostavna...
No, bez obzira na to, pogledajte donje objašnjenje koje će vam za početak biti dovoljno:
	HTML naredba
	Objašnjenje
	Rezultat u browseru

	<BODY>
&#169;<BR>
&#35;<BR>
&amp;<BR>
&quot;<BR>
&lt;<BR>
&gt;<BR>
&nbsp;<BR>
</BODY>
	
- ASCII kod zaokruženog slova C
- ASCII kod znaka #
- specijalni HTML kod znaka &
- specijalni HTML kod znaka "
- specijalni HTML kod znaka <
- specijalni HTML kod znaka >
- prazno mjesto (razmak)
	
©
#
&
"
<
> 




c) Označavanje linkova na Internetu
Svi primjeri upućivanja na neki link koje smo do sada obradili odnosili su se na HTML dokumente, fotografije ili .MID datoteke koje su se nalazile na našem računalu i koje su bile u istom folderu (direktoriju) kao i HTML dokument iz kojega su pozivani.
Iz tog razloga bilo je dovoljno navesti samo naziv željenog dokumenta u linku, bez određivanja punog puta (PATH) do njega.

Kada svoje stranice postavite na neki od servera na Internetu, morate voditi računa o slijedećim stvarima:

1. Mjesto koje dobijete na nekom Internet serveru, u smislu organizacije foldera (direktorija) ne razlikuje se puno od diska na vašem računalu. Međutim, moguće je da na besplatnim web serverima nećete imati mogućnost kreiranja nižih foldera. Ta mogućnost nije neophodna ali je poželjna, jer onda slike možete držati u jednom folderu, glazbene datoteke u drugom, itd.

2. Ako sve dokumente vezane za ispravan rad naših WEB stranica držimo na istom folderu (bilo na svom računalu ili nekom Internet serveru), tada je dovoljno da u linku na neki od tih dokumenata navedemo samo izvorno ime tog dokumenta, kako smo to radili i u svim ovim primjerima.

3. Ako dokumente na Internetu držimo u različitim (niže razgranatim) folderima, tada, ako je željeni dokument u nekom nižem folderu (koji se grana iz foldera iz kojega ga pozivamo), dovoljno je napisati:
/ImeNižegFoldera/NazivDokumenta.html (ili pak .GIF, .JPG, .ZIP ...)

4. Ako želimo napraviti link na neki dokument koji se nalazi na nekoj drugoj adresi, onda moramo navesti punu Internet adresu ili put (PATH) do tog servera i foldera. Na primjer, puni put za WEB stranice Internet Monotora bio bi:
http://www.monitor.hr/

5. Ako dobro pogledate, u prethodnom linku na Internet Monitor nismo naveli ime dokumenta koji želimo učitati već link završava sa kosom crtom ("/") a koja znači da se automatski učita fajl index.html (ili index.htm) iz tog foldera...
Čak da i nismo stavili tu kosu crtu na kraju, opet bi se automatski učitao fajl index.html, naravno, ako postoji u tom folderu!
Iz toga proizilazi da svoj "glavni" HTML dokument uvijek morate nazvati index.html (ili index.htm).
	HTML naredba
	Objašnjenje
	Rezultat u browseru

	<BODY>
Link na časopis <A HREF="http://www.monitor.hr">MONITOR</A>
</BODY>
	
- link na časopis MONITOR
(ako želite isprobati
morate biti spojeni na Internet)
	
Link na časopis MONITOR 




Dodavanje zvuka i multimedije[uredi VE | uredi]
Multimedijski objekti uključuju s na Web stranicu na tri načina: kao plug-in-ovi preglednika, ActiveX kontrole i Java appleti.

Plug-in je program uklopljen u preglednik koji proširuje njegove mogućnosti obrade multimedijskih datoteka s grafikom, zvučnim zapisima, videom... Razlikuje se od pomoćnih aplikacija (external viewer, helper application) koje se otvaraju u obliku posebnog prozora i rade nezavisno od preglednika. Za uključivanje plug-inova na HTML stranicu mogu se koristiti starija <EMBED> oznaka ili po HTML 4.01 standardu nova <OBJECT> oznaka, dok se kod najnovije verzije HTML5 koriste oznake <VIDEO> i <AUDIO>.

Sljedeći primjer koristi <EMBED> oznaku:

<HTML>
  <HEAD>
    <TITLE>Zvuk i EMBED</TITLE>
  </HEAD>
  <BODY>
    <P>Umetanje zvuka pomoću EMBED elementa</P>
    <EMBED SRC="moja_pjesma.mp3" HEIGHT="60" WIDTH="144">
  </BODY>
</HTML>
Isti primjer korištenjem <OBJECT>:

<HTML>
  <HEAD>
    <TITLE>Zvuk i OBJECT</TITLE>
  </HEAD>
  <BODY>
    <P>Umetanje zvuka pomoću OBJECT elementa</P>
    <OBJECT DATA="moja_pjesma.mp3" WIDTH="144" HEIGHT="60">
    </OBJECT>
  </BODY>
</HTML>
Primjer za HTML5:

· VIDEO oznaka

<video src="video_datoteka.mpg" width="640" height="480" controls></video>
· AUDIO oznaka

<audio src="zvučna_datoteka.mp3" controls>
· Primjer bez kontrolnog prozora, s automatskim pokretanjem (autoplay)

<audio src="zvuk.mp3" type="audio/mp3" autoplay=”false” />
· Isto tako možete za video, samo kopirate oznaku autoplay u videotag.

Html kod za video za YouTubea:
<iframe title="YouTube video player" class="youtube-player" type="text/html" width="640" height="390"

src="http://www.youtube.com/embed/W-Q7RMpINVo"

frameborder="0" allowFullScreen></iframe>
Dodavanje CSS stilova[uredi VE | uredi]
Godine 1996., W3C prvi puta spominje ideju stilskih obrazaca (CSS – Cascading Style Sheets) za oblikovanje HTML dokumenta. Standard, koji je objavljen sredinom 1998.godine, omogućuje web dizajnerima da odvoje strukturu i oblik svojih dokumenata. CSS standard određuje tri vrste stilskih obrazaca: ugrađeni, linijski i vezani.
UGRAĐENI – Stilska obilježja se ugrađuju unutar <style> taga na početku samog HTML dokumenta. Stil pridružen određenom tagu primjenjuje se na sve tagove te vrste unutar dokumenta.


Primjer
<style type="text/css">
  .ime_stila {
    font-size: 36px;
    color: #000;
    background-color: #0F0;
    font-family: Arial, Helvetica, sans-serif;
  }
  .drugi_stil { color: #0F0; }
</style>
LINIJSKI – Stilska obilježja ugrađuju se kroz cijeli HTML dokument. Svakom pojedinom HTML tagu možemo pridružiti svoja vlastita stilska obilježja.

Primjer
<p style="font-family: Arial, Helvetica, sans-serif; font-size: 36px; color: #F00;">Označeni tekst stylom</p>
VEZANI – Stilska obilježja pohranjena su u zasebnoj datoteci. Ta datoteka se može povezati s bilo kojim HTML dokumentom koristeći tag <link> koji se smješta unutar <head> taga.

Primjer
<link href="http//www.pou.com/Unnamed Site 2/style.css" rel="stylesheet" type="text/css">
d) Ostale opcije unutar HTML naredbi i kompatibilnost browsera
Do sada smo obradili samo neophodne osnove za rad u HTML-u.
I o tome morate voditi računa. Dakle, nismo obradili sve moguće funkcije HTML-a!

Osim toga HTML je jezik koji se stalno razvija i čiji je razvoj potrebno stalno pratiti.
Dobro je uključiti se na neki od foruma na Internetu u kojem se o tome raspravlja.
Osobno bih vam preporučio da bar povremeno "skoknete" i na ove stranice:

WEB konzorcij
WEB tools
DHTML Code Library

Tu ćete pronaći mnogo korisnih savjeta ne samo glede izrade HTML dokumenata već i kompatibilnosti browsera! Također, to su mjesta gdje ćete uvijek moći među prvima doznati o svim novostima glede razvoja HTML-a.

Nadalje, posebno morate voditi računa da sve HTML naredbe nemaju jednak efekat u različitim browserima! U suprotnom, vaša lijepo urađena WEB stranica koju ste testirali u Internet Exploreru u drugim browserima ne samo da može izaći krajnje neukusna, već u potpunosti može izaći nečitljiva!

No, ne brinite previše! Ako ste stvarno uspješno ovladali temama iz ove Dopisne škole HTML-a onda nemate razloga za paniku! Jer sve naredbe koje smo proradili funkcioniraju u većini standardnih browsera. A sa tim znanjem možete napraviti i više nego prosječnu HTML stranicu!

Zatim, imajte na umu da u ovoj školi nismo obradili sve HTML naredbe, a i one koje smo obradili uglavnom unutar sebe nisu sadržavale sva svojstva koja su moguća...
Ali zato ste stekli preduvjet da sve to bez problema lako shvatite i uporabite kada dođe vrijeme. U tom cilju ovdje vam dajem link na jednu datoteku pomoći u kojoj možete pregledati i naučiti o svemu onome što ovdje nismo stigli:
	HTML naredba
	Objašnjenje
	Rezultat u browseru

	<BODY>
<A HREF="html.hlp">HTML HELP</A>
</BODY>
	- link za download
	HTML HELP


 TITLE

Sintaksa <TITLE> Naslov </TITLE>

Određuje naslov prozora HTML dokumenta. 

 

META

Sintaksa <META> - nema završne oznake

Osigurava preglednicima i tražilicama dodatne podatke o dokumentu. (metapodatak-ciljni podatak). To su ime autora, ključne riječi, opis stranice, postavke jezika, i drugo. 

Ne postoji standardni popis META svojstava, tako da autori mogu definirati metapodatke po želji.

Primjer: 

<META HTTP-EQUIV="Content-Type" CONTENT="text/html; CHARSET=ISO-8859-2">

<META HTTP-EQUIV="Content-Language" CONTENT="hr">

<META NAME="description" CONTENT="Podatci o modelima zrakoplova">

<META NAME="keywords" CONTENT="Airbus, Boeing, Tupoljev">

<META NAME=author CONTENT="Ivo Ivić">

<META NAME=robots CONTENT="index,nofollow">

<META HTTP-EQUIV=Expires CONTENT="Sun, 26 Mar 2006 16:18:35 GMT">

<META HTTP-EQUIV=Refresh CONTENT="10; URL=http://www.htmlhelp.com/">

 

 

Tablica osnovnih boja – heksadekadske vrijednosti

	Ime boje
	 
	Hex RGB vrijednost

	Black
	 
	#00 00 00

	Silver
	 
	#C0 C0 C0

	Gray
	 
	#80 80 80

	White
	 
	#FF FF FF

	Maroon
	 
	#80 00 00

	Red
	 
	#FF 00 00

	Purple
	 
	#80 00 80

	Fuchsia
	 
	#FF 00 FF

	Green
	 
	#00 80 00

	Lime
	 
	#00 FF 00

	Olive
	 
	#80 80 00

	Yellow
	 
	#FF FF 00

	Navy
	 
	#00 00 80

	Blue
	 
	#00 00 FF

	Teal
	 
	#00 80 80

	Aqua
	 
	#00 FF FF
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	   POSTAVKA FTP PROGRAMA (FTP Explorer)
	


Napokon smo došli i do trenutka postavke naših web stranica i pripadajućih slika na neki od web servera!
U tom cilju objasnit ću kako to napraviti pomoću zasebnog FTP programa, u ovom slučaju FTP Explorera.
Možete ga skinuti sa http://www.ftpx.com/download.html.
Pretpostavljam da ste do sada već osigurali web prostor kod nekog davatelja usluga! Ako to niste napravili, pogledajte kako to učiniti, u sekciji HTNet free web.
Dakle, nakon instaliranja FTP Explorera, morate podesiti parametre konekcije.
Za to su vam potrebni slijedeći podaci, koje ste dobili od davatelja usluge:
- Host Address: (dobiveni podatak o adresi FTP servera)
- Port: (ako nije posebno navedeno, onda je to 21)
- Login/Username: (dobiveni podatak o vašem loginu)
- Password: (dobiveni podatak o vašem passwordu)
Po pokretanju FTP Explorera, dobit ćete ovakvo sučelje:
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Da bi podesili parametre konekcije, izaberite:
        Tools -> Connect
nakon čega ćete dobiti slijedeći dijalog:
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Ako u lijevom okviru već postoje upisani neki FTP accounti,
onda ih slobodno obrišite, jednog po jednog, gumbom Remove,
kako vam ne bi smetali pri daljnjem radu.
Nakon toga kliknite na gumb Add i popunite slijedeća polja:
    - Profile Name: (upišite neku oznaku, npr. Moj prvi site)
    - Host Address: (upišite dobiveni podatak o FTP adresi)
    - Port: 21
    - Login: (upišite dobiveni podatak o loginu ili usernameu)
    - Password: (upišite dobiveni podatak o passwordu/lozinki)
   * Ostala polja ne morate popunjavati. Ostavite ih kakva jesu!
Kada je to upisano, ne zaboravite kliknuti na gumb Save!
Preostaje još da se spojite na svoj web server gumbom Connect!
Nakon što ste se spojili na svoj web server, dobit ćete ovakav dijalog:
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... koji prikazuje sadržaj foldera i datoteka na vašem web serveru.
Naravno, u početku će sve to biti prazno, ali se ne brinite!
Prvo na web serveru morate definirati potrebne subfoldere.
Dakle, ako na svom kompjuteru imate ovakvu strukturu:
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... onda na web serveru trebate kreirati samo subfolder slike!
To napravite tako da (dok ste na root folderu servera) kliknete na:
        File -> New -> Folder
... i onda u ponuđeni dijalog upišete naziv subfoldera (npr. slike).
* Najbolje bi bilo da sve foldere i subfoldere i na svom kompjuteru
   i na web serveru uvijek imenujete samo malim slovima!
   U suprotnom, vodite računa da nazivi budu potpuno isti!
* Naravno, ako ne koristite subfoldere već sve držite u istom
   folderu, onda ni na web serveru ne morate kreirati subfoldere!
Nadalje, ne dajte da vas zbuni to što se vaš root folder na vašem web serveru (na predzadnjoj slici: site) imenom razlikuje od osnovnog foldera na vašem kompjuteru u kojem držite svoje web stranice (na zadnjoj slici: MojPrviWeb), jer to nema nikakve veze!
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	   UPLOAD DATOTEKA NA WEB SERVER (FTP Explorer)
	


Nakon što ste sve ovo podesili i uradili, preostaje tzv. upload!
(To je inače prijenos datoteka s kompjutera na vaš web server.)
Naravno, prije svega se morate konektirati na svoj web server.
To napravite opcijama:
        Tools -> Connect
pa onda u Connect dijalogu izaberite svoj web i kliknite Connect.
(Dakle, onako kako smo to opisali u pethodnom poglavlju!)
Nakon uspješnog konektiranja, dobit ćete sadržaj na svom web serveru:
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Prvo kliknite na folder na serveru u koji želite uploadati podatke.
Tek zatim pokrenite upload podataka opcijom:
        File -> Upload
i bit će vam ponuđen dijalog za izbor datoteka koje želite uploadati.
Naravno, prvo se locirajte na folder gdje držite svoje web datoteke!
Zatim izaberite one koje želite uploadati (moguć izbor više njih odjednom).
Kada ste ih izabrali, kliknite na gumb OK za potvrdu uploada... i to je to!
Dakle, u ovome postupku važno je da uvijek prvo kliknete na folder na serveru u koji želite uploadati podatke a tek zatim pokrenete upload i izaberete datoteke. Vodite računa da datoteke uploadate u foldere/subfoldere na serveru identične onima na svom kompjuteru, kako je to već prethodno i opisano!
Nakon završenog uploada uvijek se diskonektirajte sa:
        Tools -> Disconnect
... i nakon toga provjerite svoje web stranice browserom!
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	   KAKO OSIGURATI WEB PROSTOR (HThinet free web)
	


Ako želite osigurati besplatni (free) web prostor kod HThineta, jedini je uvjet da ste korisnik njihovih usluga u smislu pristupa internetu (dakle, da kod njih imate e-mail adresu, koju također dobivate besplatno).
U tom cilju odite na njihovu web stranicu:
http://www.t-com.hr/privatni/internet/hosting/free.asp
te se logirajte koristeći korisničko ime i lozinku koju ste od njih dobili prilikom ugovaranja pristupa internetu ili dobivanja e-mail adrese.
Dijalog za logiranje izgleda ovako:
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Nakon što upišete korisničko ime i lozinku, kliknite na gumb Ulaz
i onda na dobivenoj stranici kliknite na opciju Free web:
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Pročitajte uvjete za dobivanje free web prostora i ako se slažete s njima nastavite s prijavom.
Kada dobijete dijalog sličan ovome na slici:
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... izaberite željeni oblik svoje web adrese i kliknite na Kreiraj.
Ako je sve bilo OK, dobit ćete ovakvu obavijest:
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Prepišite si URL podatak jer to je vaša nova web adresa!
Također, pročitajte ponuđenu Pomoć i upute kako bi doznali podatke za postavku svojih web stranica FTP programom. To bi trebalo izgledati ovako:
FTP server: free-YY.t-com.hr
                     (YY je oznaka grada: bj-Bjelovar, zg-Zagreb...)
Port: 21
Username: <vaše HThinet korisničko ime>
Password: <vaša HThinet pristupna lozinka>
* Dakle, username i lozinku potražite u ugovoru s HThinetom...
   Zatim sve ove podatke spremite, jer će vam ubuduće trebati!
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	   ODRŽAVANJE SITEA
	


Naravno, vaš site ćete povremeno morati i održavati.
Ako ni zbog čega drugoga, onda zato što ćete vremenom dobivati sve bolje i bolje ideje kako ga učiniti ljepšim, funkcionalnijim, zabavnijim...
No, pojedini davatelji free web prostora zahtjevaju da se svakih par mjeseci napravi nekakva promjena na siteu (bar formalna, npr. upload neke datoteke), kako bi vam produžili korištenje weba.
Iz toga razloga čuvajte web datoteke na svom kompjuteru, da ih ne bi morali skidati sa servera, ali i za slučaj da nekom nesretnom okolnošću budu izgubljene na serveru!
Nadalje, sve izmjene uvijek prvo napravite na svome kompjuteru i provjerite kako nove stvari funkcioniraju. Posebnu pozornost obratite na linkove, jer s njima uglavnom i nastaju problemi!
Tek kada je sve OK, napravite upload novih i izmjenjenih datoteka na server.
Ako niste sigurni koje su datoteke nove ili mijenjane, napravite upload svih!
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